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Introduction 

This Getting Started document will help you to install and configure the Hardware and 
Software tools necessary to operate the Free TriCore Entry Tool Chain. At the end of the 
instructions described in this document, you will have a running environment that could 
be used as a starting point for further development or evaluation work. 

This tutorial goes step-by-step through the necessary procedures in order to: 

 Install the Free TriCore™ Entry Tool Chain 

 Set up a project 

 Configure the Evaluation Board and connect it to the PC 

 Debug your application 

 

If you need more information, please contact your nearest Infineon sale’s office. Contact 
information is available on Infineon web site: www.infineon.com.  

We wish you a lot of success with the Free TriCore Entry Tool Chain! 

 

Note: "Starter Kit Evaluation Board", "Evaluation Board", "TriBoard" and "Target" 
terminology are used to denote Evaluation Boards as shown in Figure 17 to Figure 29. 

  

 ! 
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Installing the Free TriCore Entry 
Tool Chain 

Before you start 

To execute this Getting Started, it is necessary to have a  

 Microsoft Windows compatible PC equipped with USB port 

 Operating System Windows 7, Windows 8.1, Windows 10 (32-bit/64-bit)  

 Power user’s or administrator rights are mandatory to install the required 
programs 

 During installation a connection to the internet is required 
for license activation 

All the items below are included in the Starter Kit. 

 Power Supply  (AC/DC converter) (5.5V – 60V) for the Starter Kit Board (optional) 

 TriCore Family Starter Kit Evaluation Board  

 Free TriCore Entry Tool Chain installation package 

 USB cable. 

System Requirements 

Before installing, make sure the following minimum system requirements are met: 

 2,5 GHz or faster 32-bit (x86) or 64-bit (x64) processor 

 4 GByte RAM (32-bit) or 8 GByte RAM (64-bit) 

 3 GByte available hard disk space 

 Microsoft .NET™ Framework 3.5 SP1 

 Microsoft Windows Scripting Host V5.6 

 Microsoft Internet Explorer® 10 or higher  

 Java Runtime Environment v8 (32-bit version)  

 Adobe® Acrobat Reader 10.0 or higher. 



 

Installing the Free TriCore Entry Tool Chain   7 of 40 

Installation 

1. From the installation package run the installer setup.exe. Free TriCore Entry Tool 
Chain dialog appears (Figure 1) 

 

 
Figure 1 Free TriCore Entry Tool Chain Setup dialog 

 

2. Select Next button. The License Agreement dialog appears. Please read carefully 
and agree or cancel the installation with Cancel button (Figure 2) 

 

 
Figure 2 License Agreement dialog 
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3. Select Next button. In the next dialog you can decide if the tool chain will installed 
only for your profile or for all users of the computer (Figure 3) 

 

 
Figure 3 Free TriCore Entry Tool Chain Setup dialog 

 

4. Click Next button. The dialog for selecting the installation directory appears (Figure 
4). Use the default or select another installation directory. 

 

 
Figure 4 Free TriCore Entry Tool Chain Setup folder dialog 
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5. Click Next button. Select the destination of the installation. 

 

 

 

6. Click Next. Now the Product Selection dialog with the predefined product key 
appears (Figure 5). No user action is needed. 

 

 
Figure 5 ProductSelection dialog 
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7. Click Next. Further dialogs inform you about the progress of installation. 

Please note: For commercial development you need the full version of TriCore 
Development Platform.  

The Free TriCore Entry Tool Chain cannot be used together with professional versions 
of the containing products because they are incompatible. That’s why, it is not possible to 
use a parallel installation of the Free TriCore Entry Tool Chain together with a 
professional version UDE 4.10. 

 

Note: The Free TriCore Entry Tool Chain license is valid for at least one year. There are 
following restrictions in comparison to the professional version: 

Useable for TriCore evaluation boards with on-board wiggler only, PCP assembler only, 
Debugger: No visualization functions at runtime, no MCDS support, no Script support. 

Please contact tctcsupport@pls-mc.com for extending the license. 

 
 

 ! 

 ! 
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First Starting of Eclipse 

Starting Eclipse 

1. From the Windows’ Start menu, select All Programs – AURIX 2G - Free Entry Tool 
Chain v4.9.1.0-infineon-2.0 – Eclipse or use the Desktop icon Eclipse for TriCore. 

2. Now the Workspace Launcher dialog appears (Figure 6). 

 

 
Figure 6 Workspace Launcher 

3. Enter the path to the workspace directory e.g. D:\Workspace. If the directory 

doesn’t exist, new directory will be created; otherwise existing directory will be used 
as eclipse workspace. New created projects will be saved in the selected workspace 
directory.  

4. You can enable the option Use this as the default and do not ask again. By next 
start last used workspace will be used, skipping the Workspace Launcher dialog. If 
you want to use other or new workspace. Select from the File menu Switch 
Workspace. 

5. Click OK to proceed. 

6. The HighTec Licensing dialog appears (Figure 7) 

 

 
Figure 7 HighTec Licensing dialog 

Click Yes to proceed. 
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7. To add a license a dialog for Activation and Registration of a license appears  
(Figure 8). 

 

 
Figure 8 Add license dialog 

It shows the products for the license activation. Further some data are requested. User 
name, e-mail address and company are needed and department and phone number are 
optional. 

8. After pressing Finish the license will generated. The license file is located in the 
directory where the environment variable HTC_LICENSES points to and is also 
visible in the license manager page of eclipse plug-in from HighTec. 

Note: License activation fails if the Avira Security Suite is used. The error message is: 
"Bad return data from webserver (no status)(-134)". Please deactivate the browser 
protection for a short time to allow license activation. 

The Welcome view appears. 

Note: Step 2 to 4 are needed only at the first time start. 

Initially, Eclipse opens with a workbench displaying the C/C++ perspective with only the 
Welcome view visible. This view provides some general information and alternative ways 
to access the online documentation. 

Eclipse opens with the perspective which was last used before closing, except when 
starting up for the very first time showing the Welcome view. 

 

 ! 
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9. Click the Workbench on the right side of the view to go to the workbench. Assuming 
first start of eclipse, HighTec perspective (Figure 9) appears, otherwise last saved 
workbench layout. 

 

 
Figure 9 HighTec perspective 
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Create an AURIX Project 

C/C++ Project wizard 

This tutorial shows how to create an embedded software project with the TriCore toolset. 
It lets you create your own project with an example of an analogue clock on the display of 
the AURIX application kit.  

Set the HighTec C/C++ perspective 

Before creating a TriCore project, it is necessary to have the HighTec C/C++ perspective 
on the workbench (Figure 11). By default, this should be the case when you start Eclipse, 
but if it is not, do the following. 

To open the HighTec C/C++ perspective 

1. From the Window menu select Open Perspective - Other... - HighTec. The name 
of the perspective is displayed in the title bar of the workbench window. 
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Import a sample Project 

1. From the File menu select New - Example (Figure 10). The New Example wizard 
appears (Figure 11). 

 

 
Figure 10 Menu File / New / Example 

2. Select HighTec Examples and press Next. 

 

 
Figure 11 New Example Wizard 
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3. The next wizard page (Figure 12) shows a selection tree containing the TriCore 
boards supported by the toolchain. Expand the sample node e.g. TimeDemo and 
select TriBoard TC26x A-Step. Press Next. 

 

 
Figure 12 Examples – Hardware Selection 

4. Click Finish to finish the wizard and to import the example.  

Figure 13 shows HighTec perspective with the new created project. To see the generated 
project files you may need to expand the hello project structure on the left pane. To open 
one generated file double-click the file in the src folder of the project structure. 

 

 
Figure 13 HighTec C/C++ Perspective with the new imported example 
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Start with an empty Project 

To start from an empty project following the steps from the previous section Import a 

sample project and simply remove all header files from the h folder and the file timer.c 

from the src folder and delete the content of the file timedemo.c except an empty 

main() function.  

Build the Project 

When you build an AURIX C/C++ project in Eclipse, the HighTec TriCore compiler, 
assembler and linker are used to compile and link all the source code and the libraries 
associated with the project.  

The wizard generates different build targets like iROM (default). You can choose a build 

configuration by clicking the arrow of the build icon and build a target by clicking the 

build icon .  

Meaning of build targets 

 iROM Code will be located in the internal flash (default) 

During the build process the sources belonging to the project will be compiled and linked. 
The messages occurring during the build process are displayed in the Console window 
(Figure 14).  The build process should terminate without giving any errors or warnings. 

 

 
Figure 14 HighTec C/C++ Perspective: Build button and Console window 
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Connecting the Target 

TriBoard with mounted TC38xA, TC39xA, TC39xB 
processor 

1. Configure the DIP switches (1,2,3=OFF 4=ON but for A step (!) 1=ON 2,3,4=OFF)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 15 AURIX – TriBoard 
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Application Kit AURIX TC397 TFT with TC397A, TC397A 
(ADAS) 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC397 to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the Reset button (see picture below) 

 

 
 

 

 

 

Back side Top side 

 
Figure 16 AURIX Application Kit TC397 TFT 
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TriBoard with mounted TC2D5T, TC21xA, TC22xA, 
TC23xA, TC26xA, TC26xB, TC27xA, TC27xB, TC27xC, 
TC27xD, TC29xA, TC29xB processor 

1. Configure the DIP switches (1,2,3=OFF 4=ON but for A step (!) 1=ON 2,3,4=OFF)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 17 AURIX – TriBoard 
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Application Kit AURIX TC2X4 TFT with TC224, TC234 
(TLF35584A, TLF35584B, TLF35584C) 

5. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

6. Connect the Application Kit TC2X4 to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

7. The Power Supply  LED should be on. 

8. Press the Reset button (see picture below) 

 

 
 

 

 

 

Back side Top side 

 
Figure 18 AURIX Application Kit TC2X4 TFT 
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Application Kit AURIX TC2X5 TFT with TC265B, 
TC275A, TC275B, TC275C  

 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC2X5 to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the Reset button (see picture below) 

 

 

 

 

Back side Top side 

 
Figure 19 AURIX Application Kit TC2X5 
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Application Kit AURIX TC2X7 TFT with TC237, TC267B, 
TC277C, TC277D, TC297B 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC2X7 to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the Reset button (see picture below) 

 

 

 

 

Back side Top side 

 
Figure 20 AURIX Application Kit TC2X7 
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ShieldBuddy TC275C, TC275D 

1. Configure the Power Supply Jumper to VUSB.  

2. Connect the ShieldBuddy to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. Three Power Supply LEDs should be on. 

4. Press the Reset button (see picture below). 

 

 
Figure 21 ShieldBuddyTC275 
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TriBoard with mounted TC1767 processor 

5. Configure the DIP switches (default all OFF - boot from internal flash)  

6. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

7. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

8. Three Power Supply PS-LEDs should be on. 

9. Press the Reset button (see picture below). 

 

 
Figure 22 TC1767 - TriBoard 
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TriBoard with mounted TC1797 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below). 

 

 
Figure 23 TC1797 - TriBoard 
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TriBoard with mounted TC1782 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below). 

 

 
Figure 24 TC1782  - TriBoard 
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TriBoard with mounted TC1724 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below). 

 

 
Figure 25 TC1724  - TriBoard 
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TriBoard with mounted TC1791 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below). 

 

 
Figure 26 TC1791  - TriBoard 
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TriBoard with mounted TC1793 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below). 

 

 
Figure 27 TC1793  - TriBoard 



 

Connecting the Target   31 of 40 

TriBoard with mounted TC1798 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below). 

 

 
Figure 28 TC1798 - TriBoard 
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phyCORE-TC1793 with baseboard 

1. Connect a DC power supply (5.5V – 60V) to the baseboard 

2. Connect the baseboard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the Reset button (see picture below). 

 

 
Figure 29 phyCORE - TC1793 with baseboard 
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Debugging your Application 

Start a Debug Session  

1. Click at the debug button  and select Debug Configurations ... (Figure 30). 

 

 
Figure 30 Select Debug Configurations dialog via Debug button 
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2. The Debug Configurations dialog appears. Select Universal Debug Engine as 
debug type (Figure 31). 

 

 
Figure 31 Debug Configurations dialog 

3. Press the New launch configuration button to create a new debug launch 
configuration for Universal Debug Engine (Figure 32). 

 

 
Figure 32 Create new debug launch configuration for Universal Debug Engine 

4. A new debug configuration TimeDemo_TriBoard-TC275A is created. All input fields 
are pre-filled with appropriate values (Figure 33). 

5. Push Debug to start UDE perspective. Later you can use the Debug icon  from 
the menu. 
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Note: If a problem occurred pop-up window appears, click OK, check the USB cable 

connection, reset the board with the reset button, and start again the Debug session  

6. If you built an iROM version of your application, the UDE Memory Programming 
Tool will appear after launching the UDE perspective (Figure 33). 

 

 
Figure 33 UDE Memory Programming Tool 

7. Start flashing with the Program button. A progress dialog appears (Figure 34). After 
successful programming close both dialogs. 

 

 
Figure 34 FLASH programming progress dialog 
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From the Debug menu, select Step over subroutine, or click on the Step over button 

 in the toolbar. At this moment your application is executing but stopped on the 

function main(). This means the C startup code has been executed completely. The 

Editor view shows the C source files of your application and a yellow arrow shows the line 
where the execution has stopped (Figure 35). 

 

 
Figure 35 First step to main() function 

Stepping through the Application 

1. From the Debug menu select Step over subroutine or click on the Step over button  

 in the toolbar. The yellow arrow in the Program view moves to the next 
statement. 

2. To set or clear breakpoints click on the markers in the info margin of program 
window. 

3. To see watch or local variables please open the accordingly window 
via the View menu. 

4. To run your application, select Start Program Execution from the Debug menu or 

click on the Start Program button  in the toolbar. Now an analogue clock should 
be visible on the display of the application kit. 

5. To restart your application, select Restart Program Execution from the Debug 

menu, or press F7 or click on the Restart button  in the toolbar. 
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Using the UDE debugger 

The main() and further features of UDE are described in the UDE Manual, available via 
UDE Welcome Page. Open it via menu Window - Show View - Other ... - Universal 
Debug Engine - UDE Welcome Page and push the UDE Manual button.  

Figure 36 shows an UDE example configuration with Peripheral Registers, Call stack, 
Watch window, and Memory window. All features are described in the UDE Manual. 

 

 
Figure 36 Universal Debug Engine perspective 
 

End the Debug Session 

From the File menu select Close Workspace or click on the Close Workspace  button 
in the toolbar. The current perspective is switched back to the HighTec C/C++ 
perspective. 
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Summary 

Having followed the step-by-step instructions the development environment comprising 
Free TriCore Entry Tool Chain and TriCore Family Evaluation Board will have now been 
installed. After creating and compiling a simple program, it is successfully executed on 
the Evaluation Board. 

You now have a running environment that could be used for further development or 
evaluation work. 
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